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Metabolic Case Study IVGTT Cold Glucose Minimal Model 

 
The Minimal Model of Cold Glucose Kinetics 

 
Prerequisites 
 

The prerequisite for this case study is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this case study 
 

• How to work with IVGTT data 
• How to create a forcing function for insulin concentration 
• How to correct for baseline concentrations 
• How to define the minimal model parameters 

 
Data Required 
 

The data file for this case study is 
 

IVGTT.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
The IVGTT results in glucose and insulin measurements obtained in plasma in a (human 
or animal) subject after an intravenous pulse dose of glucose. These data can be used to 
obtain estimates of insulin sensitivity and glucose effectiveness for this subject. 
 
This case study will show you how to implement the minimal model of glucose 
disappearance in SAAM II. It also serves as an example of how to implement nonlinear 
differential equations and forcing functions. Some references and more about the minimal 
model are reported at the end of this case study (Modeling Notes). 
 
The notation and minimal model differential equations are shown below. The first 
equation represents glucose kinetics, and the second represents insulin action. 
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where, assuming time is expressed in minutes: 
 
• q(t) is glucose mass (mg/kg body weight) in plasma, 
• x(t) is insulin action (min-1), 
• p2 is an insulin action parameter (min-1), 
• I(t) is the measured plasma insulin concentration (�U/ml), 
• D is the exogenous glucose dose (mg/kg), 
• V is the glucose volume of distribution (dl/kg body weight), 
• G(t) is the measured plasma glucose concentration (mg/dl), 
• SG is glucose effectiveness (units of inverse time, or min-1), 
• SI is insulin sensitivity (units of inverse time per unit insulin concentration, or min-1 

per �U/ml), 
• q(0) is the initial condition in the glucose compartment, 
• x(0) is the initial condition in the insulin action compartment, 
• Gb is basal glucose, and 
• Ib is basal insulin. 
 
Thus, in terms of SAAM II, there will be two models. One will describe the insulin action 
differential equation. The other will implement the glucose disappearance differential 
equation. The parameters to be estimated from data are: SG , SI, p2 and V.  
 
1. Bergman RN, Lovejoy J, Eds. The Minimal Model Approach and Determinants of 

Glucose Tolerance. Baton Rouge, LA: Louisiana State University Press, 1997. 
 
 
    
Part 1.  Create a two-compartment model in the SAAM II Compartmental 

application to implement the insulin action equation 
 
This part of the case study will show you how to implement the insulin action equation 
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by creating the following two-compartment model in the SAAM II Compartmental 
application: 
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In implementing the insulin action equation in the context of this model, k(0,2) will be 
used to describe the term –p2x(t) and compartment 3 will be specified as a forcing 
function to describe the term –p2SI[I(t)-Ib].  
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Create the following system model on the Drawing Canvas. 
 

 
In creating this system model, you will need to renumber Compartment 1. 
Remember this is done by double-clicking on Compartment 1 to open the 
Compartment Attributes dialog box, changing the Compartment Number 
from “1” to “3”, and clicking Done. 
 

3. Create the experiment describing insulin action. 
 

a. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 
unavailable and the Experiment tools are available. The Experiment 
Attributes dialog box will open. 

 
b. Be sure the entry in the Units box is minutes. 
 
c. Enter “240” in the End at box. The Experiment Attributes dialog box will 

appear as follows: 
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a. Click Done.  
 

The Create Experiment dialog box will appear on the Drawing Canvas. Type 
“IVGTT” in the New Name box. The Create Experiment dialog box will appear 
as follows: 

 

 
 

e. Click Create. Notice “IVGTT” now appears below Experiment in the 
SAAM II Toolbox. Your model will appear as follows: 

 

 
 

4. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file IVGTT.dat should appear in the list (if 

it does not, find the folder where you put this data file). 
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c. Double-click IVGTT.dat. The data in this file will appear in the Data 
window as follows: 

 

 
 

 Entering constants in a Data file. The data file contains two columns of data. 
One is “G” for glucose and the other “I” for insulin. You will notice in the 
data file, following the END statement, the lines “CONST Gb 93”, “CONST 
Ib 11.3” and “CONST D 305.” These are respectively the baseline levels for 
glucose and insulin, and the dose. You can enter constants in your model 
using the CONST designator. Constants, so designated, must lie outside a data 
stream, i.e. streams between DATA and END. The “(-)” following the first 
few glucose data mean these data are unweighted. This will be explained later 
in the Case Study. 
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 Notice also there are data at time zero. This is quite unusual in most 
experiments. However, to use the Forcing Function machinery in SAAM II as 
is done in this case study, a datum is required at time zero. 

 
 

d. Close the Data window. 
 

5. Create the forcing function for Compartment 3. 
 

a. Double-click Compartment q3. The Compartment Attributes dialog box 
will open as follows: 

 

 
 

b. Click Forcing Function…. The Forcing Function dialog box will open. The 
two dialog boxes will appear as follows: 

 

©University of Washington  IVGTT - 6    Rev. 04/04/15 



Metabolic Case Study IVGTT Cold Glucose Minimal Model 

 
 
c. Select the Equation for q3.FF option. 
 
d. In the Equation box, type “q3.FF=lin(I)-Ib”. The Forcing Function dialog 

box will appear as follows: 
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e. Click Done to close the Forcing Function dialog box. 
 
f. Click Done to close the Compartment Attributes dialog box. Your model 

will appear as follows: 
 

 
 

 The forcing function equation. The forcing function equation illustrates two 
important features of SAAM II. First, “lin(name)” is an option in SAAM II 
which will create a function by linearly interpolating between sequential data 
in the “name” data column. In this case, it is the insulin data “I.”  The same 
could be accomplished using the “Associate with Data Name” option except 
for one important thing. Basil insulin levels need to be subtracted from each 
datum. The basil insulin level, “Ib”, which is entered in the data file, is 
subtracted from “lin(I)” thus producing a forcing function due to the insulin 
increase above baseline. 

 
 Notice also the “FF” associated with Compartment q3; this shows the 

designation of this compartment as a forcing function. 
 
 In this particular situation, depending upon the “quality” of the data and the 

value for Ib, it is possible the numerical value for the forcing function could 
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be negative. Given the forcing function definition is using the “convenient” 
method, this is normally okay. However, if the data are quite noisy, or the 
function is negative over a large time span of the experiment, you should 
consider a functional description of FF which prevents the values from going 
negative. 

 
 

6. Define the transfer attributes for k(2,3) and k(0,2). 
 

In what follows, the transfer attributes for k(2,3) and k(0,2) will be defined. How 
these relate to the differential equation for insulin action will be explained at the 
end of this section. 

 
a. Double-click k(2,3) to open the Transfer Attributes dialog box.  
 
b. In the Equation pane, type “k(2,3)=SI*p2”. The Transfer Attributes dialog 

box will appear as follows: 
 

 
 

c. Click Done. 
 
d. Double-click k0,2) to open the Loss Attributes dialog box.  
 
e. In the Equation pane, type “k(0,2)=p2”. The Loss Attributes dialog box will 

appear as follows: 
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f. Click Done. 
 

 The minimum model second (insulin action) equation. At this point, you have 
successfully implemented the second equation of the minimal model. You can 
verify this simply writing the differential equation for q2 and see that it is the 
same as that provided above for the time course of insulin action: 

 

])([)(]})([)({)(
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dt
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Remembering that q2(t) plays the role of x(t) in the equation, defining “k(0,2) 
= p2” will create the term -p2*q2(t) in the differential equation dq2/dt. Now 
with q3 defined as a forcing function, dq2/dt will “see” q3.FF, not q3. Thus 
defining “k(3,2) = SI*p2” will create the term SI*p2*(lin(I)-Ib) in the 
differential equation for q2; this is the equivalent of . ])([2 bI ItISp −

 
 
Part 2.  Create a one-compartment model in the SAAM II Compartmental 

application to implement the glucose disappearance equation 
 

This part of the case study will show you how to implement the glucose disappearance 
equation 
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by creating the following one-compartment model in the SAAM II Compartmental 
application: 
 

 
 
In implementing the glucose disappearance equation in the context of this model, k(0,1) 
will be used to describe the term –[SG+x(t)]q(t) and the input into Compartment q3 will 
be used to describe the term SGGb. 
 

1. In the SAAM II Toolbox, click Model to make the Model tools available. Create 
the one-compartment model shown above. The two models (following some re-
arrangements) should appear on the Drawing Canvas as follows: 

 

 
 
2. In the SAAM II Toolbox, click Experiment. Notice the Experiment Attributes 

dialog box does not open. This is because the attributes have already been 
defined. Your models will appear as follows: 
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3. Define the loss attributes for k(0,1). 

 
a. Double-click k0,1) to open the Loss Attributes dialog box.  
 
b. In the Equation box, type “k(0,1)=SG+q2”. The Loss Attributes dialog box 

will appear as follows: 
 

 
 

c. Click Done. 
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4. Define the input into Compartment q1, the glucose system. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1, and then click on the Drawing Canvas. An input 

arrow named ex1 will appear on the drawing canvas pointing to Compartment 
q1. 

 
c. Double-click ex1. The Exogenous Input dialog box will open. 
 
d. In the Name box, type “IVGTT”.  
 
e. In the Input Type box, select Equation. 
 
f. In the Equation box, type “IVGTT=SG*Gb*V”. 
 
g. In the Event Start box, enter “0”. 
 
h. In the Event Stop box, enter “240”.  
 
i. Click Add. 
 
j. In the Equation box, type “IVGTT=Gb*V+D”. 
 
k. In the Event Start box, enter “0”. 
 
l. In the Event Stop box, enter “0”.  
 
m. Click Add. The Exogenous Input dialog box will appear as follows: 
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n. Click Done.  

 

 Naming the exogenous input. Because you entered the name “IVGTT” in the 
Name box in the Exogenous Input dialog box, the name “IVGTT” will 
appear associated with the input instead of the default “ex1”. In addition, the 
input equations are defined in terms of “IVGTT” instead of “ex1”. This is 
shown below. 

 
 

5. Create a sample and define the measurement equation. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The sample s1 

will appear. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. In the Associate with Data Name box, type “G”. 
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e. In the Equations box, type “s1=q1/V”. The Sample Attributes dialog box 
will appear: 

 

 
 

f. Click Done. Your models will appear as follows: 
 

 
 
 
 

 The minimum model first equation for glucose disappearance. At this point, 
you have successfully implemented the first equation of the minimal model 
describing glucose disappearance. Remember here that “q(t)” in the first 
equation is “q1” in the model, and that “x(t)” in the first equation is “q2” in 
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the model. Defining “k(0,1)=SG+q2” will create the term -(SG+q2)*q1 which 
is the first term in the first equation. The equation input SG*Qb*V will create 
the second term where Qb*V will convert basal glucose concentration to basal 
glucose mass. 

 
 

6. View the differential equations created by SAAM II. 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar click Equation . The Equations dialog box will open. 
 
b. In the View menu, click Diff. Eq. The Equations dialog box will appear as 

follows (you will have to scroll in the Equations Defined Elsewhere box to 
see the differential equations): 

 

 
 
c. Close the Equations dialog box. 

  
 Part 3.  Enter the parameter values, Solve the model, Fit the model to the data and 

view the solution. 
 
Before you can “Solve” (simulate) your model or “Fit” your model to your data, you 
must provide numerical estimates for the primary parameters of your model. These are 
the parameters that appear in the Parameters dialog box. 
 

1. Enter the parameter values. 
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a. In the Show menu, click Parameters, or alternatively, in the SAAM II 

Toolbar click Parameters . The Parameters dialog box will open. 
 
b. If SG is not selected, double-click SG  to select it. Be sure the Adjustable 

option is selected. 
 

c. Enter “0.024” in the Value box, and click Save. 
 

d. Double-click SI to select it. 
 
e. Enter “0.0004” in the Value box, and click Save. 
 
f. Double-click V to select it. 
 
g. Enter “1.45” in the Value box, and click Save. 
 
h. Double-click p2 to select it. 
 
i. Enter “0.05” in the Value box, and click Save. The Parameters dialog box 

will appear as follows: 
 

 
 

j. Click Done. 
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2. Solve your model and view the solution. 

 
a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Tables Variables dialog box will open as 
follows (if does not open as shown below, be sure the List All Variables 
check box is not selected). 

 

 
 
b. Click s1:G; these variables will move to the Current Selection pane. 
 
c. Click Done. The plot of s1 and G will appear as follows (in linear mode): 
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 Unweighting data. Notice in the plot the red “x” through the first few data; this 
signifies these data do not have weights associated with them, and will not be 
used in the fitting process. This is typical for the IVGTT glucose minimal 
model, i.e. the data up to 10 minutes are unweighted, that is, they will not be 
used when you Fit your model to your data. 

 
 

4. Change the scale of your plot. 
 

a. In the Set menu, click Plot/Table scale. The Plot and Table Scale dialog box 
will open. 

 
b. In the Y Axis box, click Set. 

 
c. In the Minimum box, enter “0”. In the Maximum box, enter “325”. The Plot 

and Table Scale dialog box will appear as follows: 
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d.  Click Done. The plot will now appear (in linear mode) as follows: 

 

 
 

Changing the plot scale allows you to better visualize the initial decaying 
portion of the glucose data. 

  
5. With the Plot window open, Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . When you have “Fitted” your model to your data, your plot 

should appear as follows: 
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b. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window should appear as 
follows: 
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 Statistics window. The Statistics window contains information about the “Fit.” 
Notice that information about the input IVGTT appears in the “Derived 
Variables” in the Parameter/Variable pane. The reason why is that the model 
parameters SG and V appear in the equation for IVGTT. 

 
 

6. (Optional) Record you results in the Notes window. If you do not do this part of 
the Case Study, close the Statistics and Plot windows. Quit the SAAM II 
Compartmental application. You may save this file for future reference if you 
wish. 

 
a. Close the Plot window. 
 
b. In the Statistics window, in the Parameter/Variable pane, select the 

parameters and derived variables. 
 
c. In the Edit menu, click Copy. 
 
d. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar, 

click Notes . The Notes window will open. 
 
 e. In the Notes window, type “Results of the Minimal Model.” 
 
f. In the Edit menu, click Paste. The statistical information will be pasted into 

the Notes window. The titles of the columns in the statistics window will not 
be copied, so you will have to title the columns (as shown below). 

 
g. In the Statistics window, select and copy the information about the fit in the 

lower pane. Paste this in the Notes window. The Notes window will appear as 
follows: 
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 Notes. The Notes window allows you to keep track of what you did during 
your modeling exercise. If you save the study file, the notes are saved as part 
of the file so you can return to them when you run the study file another time. 

 
 

h. Close the Notes and Statistics windows. 
 
You may save your study file if you wish for future use.  
 
Quit the SAAM II Compartmental application. 
 
 
 
Modeling Notes: 
 
• More details on the minimal model method, its realm of applicability and various case 

studies can be found in the text: Bergman RN, Lovejoy J, Eds. The Minimal Model 
Approach and Determinants of Glucose Tolerance. Baton Rouge, LA: Louisiana 
State University Press, 1997. 

 
• An implementation of the minimal model is also suggested in the SAAM II reference, 

Barrett PH, Bell BM, Cobelli C, Golde H, Schumitzky A, Vicini P, Foster DM. 
SAAM II: Simulation, Analysis, and Modeling Software for tracer and 
pharmacokinetic studies. Metabolism 47: 484-492, 1998. 
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• More detailed information on implementing the various minimal models in SAAM II 
can be found:  

 
http://depts.washington.edu/rfpk/pdfs/MinimalModelTutorialVer1-1.pdf

 
Essential Points to Remember 
 

• The minimal model exercises two of the tools that SAAM II makes available: the 
forcing function (through the definition of insulin action on glucose 
disappearance, x(t)) and nonlinear equations (through the definition of the time-
varying rate of glucose disposal, SG + x(t)). 

• Usually, data up to 8 minutes after the glucose bolus are unweighted so that 
glucose disappearance can be described by a single compartment. 

• Baseline values of glucose and insulin are chosen in one of two ways: as the 
average of the pre-test values (usually, three values taken 30 minutes before the 
glucose bolus), or as the average of the end-test values (usually, of the values at 
180, 210 and 240 minutes). In healthy volunteers, this choice is almost always 
irrelevant, but in pathologies it may make a difference. Consult the published 
literature about the most common strategy. 

• Although the SAAM II implementation may appear cumbersome, it makes use of 
simple mass balance principles. 

• While the parameters we have used here are for healthy volunteers, their values 
can change considerably in various disease states. Reference values can be found 
in the literature. 

• The Notes window provides a convenient way to keep track of your modeling 
exercise. 

• This model can serve as a template for the cold minimal model for an IVGTT 
glucose tolerance test. 
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Data for this case study   
 
# Sample IVGTT data  
DATA  
t G (FSD 0.02)  I  
0     96 (-)   16  
2     312 (-) 120  
3     291 (-) 101  
4     289 (-) 107  
5     271 (-)  83  
7     241 (-)  49  
10    220      54  
15    184      49  
20    170      38  
25    151      43  
30    141      38  
35    121      25  
40     94      27  
50     88      11  
60     80      11  
70     83      10  
80     84      10  
100    90      12  
120    89      11  
140    90      17  
160    91      18  
180    87      11  
210    98      14  
240    94      9  
END  
CONST Gb  93  
CONST Ib 11.3  
CONST D 305 
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